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1 Introduction

1.1 Add-onModule RF-/ALUMINUMADM

TheAluminumDesignManual [1] provides design rules for aluminum structures in theUnited States
of America. With the add-on modules RF-ALUMINUM ADM (for RFEM) and ALUMINUM ADM (for
RSTAB), users obtain highly efficient and universal tools to design aluminum structures modeled
with member elements according to this Specification.

This manual describes the add-on modules of both main programs conjointly under the designa-
tion RF-/ALUMINUMADM.

RF-/ALUMINUM ADM carries out all typical ultimate limit state designs and stability analyses using
either the allowable strength or load and resistance factor design method. They include the
calculation of the allowable stresses for sections subject to tension, compression, flexure, shear,
torsional or flexural-torsional buckling, as well as the design for combined forces.

For the stability analysis, you can specify for eachmember or set ofmemberswhether flexural buck-
ling in the y- and/or z-direction is possible. You can also define additional lateral restraints in order
to represent themodel close to reality. From the boundary conditions, RF-/ALUMINUMADM deter-
mines the slenderness ratios and the elastic critical buckling loads. The point of load application
is considered as well, which has an effect on the torsional resistance.

For structures with slender cross-sections, the serviceability limit state represents an important
design. The load cases, load or result combinations – defined with the relevant safety factors –
can be adequately selected for the deflection analysis. If necessary, you can adjust the limit
deformations to your specific demands.

The program allows you to optimize cross-sections and export the modified cross-sections to
RFEMor RSTAB. Using the design cases, you can design separate structural components in complex
structures or analyze variants.

SinceRF-/ALUMINUMADM is integrated in themainprogramsRFEMandRSTAB, thedesign relevant
input data is already available when you open the module. After the calculation, you can evaluate
the designs graphically in the RFEM or RSTAB work window.

Last but not least, it is possible to cover the analysis progress in the global printout report, from
the determination of internal forces up to the results of the design.

We hope you enjoy working with RF-/ALUMINUM ADM.

Your DLUBAL team

1.2 Using theManual

Topics like installation, graphical user interface, results evaluation, and printout are described in
the manual of the main programs RFEM or RSTAB. The present manual focuses on typical features
of the RF-/ALUMINUM ADM add-on module.

The explanations in this manual follow the sequence of the input and result windows. In the text,
the described buttons are given in square brackets, for example [Viewmode]. At the same time,
they are pictured on the left. Expressions appearing in dialog boxes or windows are set in italics.

At the end of the manual, you find the index. However, if you still cannot find what you are
looking for, please check our website www.dlubal.com where you can go through the FAQ pages
by selecting specific criteria.

https://www.dlubal.com/en-US/support-and-learning/support/faq
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1.3 Starting RF-/ALUMINUMADM

In RFEM/RSTAB, you have two options to start the add-on module RF-/ALUMINUM ADM.

Menu
To start the program from the RFEM or RSTAB menu bar, click

Add-onModules → Design - Aluminum → RF-/ALUMINUMADM.

Figure 1.1: Menu Add-onModules→Design - Aluminum→ RF-ALUMINUMADM

Navigator
As an alternative, you can start the add-on module in the Data navigator by clicking

Add-onModules → RF-/ALUMINUMADM.

Figure 1.2: Data navigator Add-onModules→ RF-ALUMINUMADM
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2 Input Data
When you start the add-on module RF-/ALUMINUM ADM, a new window appears. In this window,
a navigator is displayed on the left, managing all available tables. The drop-down list above the
navigator contains the design cases (see Chapter 7.1, page 54).

The design-relevant data is defined in several input windows. When you open the add-on module
for the first time, the following parameters are imported automatically:

• Members and sets of members

• Load cases, load and result combinations

• Materials

• Cross-sections

• Effective lengths

• Internal forces (in background, if calculated)

To select a window, click the corresponding entry in the navigator. To set the previous or next
input window, use the buttons shown on the left. You can also use the function keys to select the
next [F2] or previous [F3] window.

[OK] saves the results. Thus, you exit RF-/ALUMINUM ADM and return to the main program RFEM
or RSTAB. To quit the add-on module without saving the new data, click [Cancel].

2.1 General Data

In the 1.1 General DataWindow, you can select the members, sets of members and actions you
want to design. The two tabs manage the load cases, load and result combinations for the ULS
and SLS analyses.

Figure 2.1: Window 1.1 General Data
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Design of

Figure 2.2: Design of members and sets of members

The design can be carried out forMembers and Sets ofMembers. If youwant to design only selected
objects, clear the All check box. Then you can access the text boxes and enter the numbers of
the relevant members or sets of members. You can remove the list of numbers in the text boxes
with the [Delete] button. Use the [Select] button to choose the objects graphically in the RFEM or
RSTAB work window.

When you design a set of members, the program determines the extreme values of the analyses
of all members contained in the set of members and takes into account the boundary conditions
of connected members for the stability analysis. The results are shown in the result Windows
2.3 Design by Set of Members, 3.2 Governing Internal Forces by Set of Members and 4.2 Parts List by Set
of Members.

Click [New] to create a new set of members. The dialog box that you already know from RFEM or
RSTAB appears where you can define the parameters of the set of members.

Design According to

Figure 2.3: Design according to ASD or LRFD

In the drop-down list box in the upper-right corner of the window, you can select the design
method for strength. The design for strength using the provisions for Allowable Strength Design
ASD 2020 is based on [1] Equation B.3-2:

Ra ≤ Rn
𝛺

(2.1)

The design for strength using the provisions for Load and Resistance Factor Design LRFD 2020 is
covered by [1] Equation B.3-1:

Ru ≤ 𝜙Rn (2.2)

If amodel has to be recalculated according to the revised Specifications ADM2015 [2] or ADM2010
[3], the respective items can be selected from the list.

Comment

Figure 2.4: User-defined comment

In this text box, you can enter user-defined notes, for example to describe the current design case.
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2.1.1 Ultimate Limit State

Figure 2.5: Window 1.1 General Data, tab Ultimate Limit State

Existing Load Cases and Combinations
This column lists all load cases, load and result combinations that have been created in RFEM or
RSTAB.

Use the button to transfer the selected entries to the Selected for Design table on the right.
Alternatively, you can double-click the entries. To transfer the entire list to the right, use the
button.

To transfer multiple entries of load cases, click the entries while pressing the [Ctrl] key, as common
for Windows applications. Thus, you can transfer several load cases at the same time.

Load cases marked in red cannot be designed: This happens when the load cases are defined
without any load data or contain only imperfections.

At the end of the list, several filter options are available. They will help you to assign the en-
tries sorted by load case, load combination, or action category. The buttons have the following
functions:

Select all cases in the list

Invert selection of load cases

Table 2.1: Buttons in tab Ultimate Limit State

Selected for Design
The column on the right lists the load cases as well as the load and result combinations selected
for design. Use the button or double-click the entries to remove selected entries from the list.
Use the button to transfer the entire list to the left.

Result combination

The design of an enveloping max/min result combination is performed faster than the design of
all contained load cases and load combinations. However, the analysis of a result combination has
also disadvantages: First, the influence of the contained actions is difficult to discern. Second, for
the determination of the elastic critical momentMe for lateral-torsional buckling, the envelope of
the moment distributions is analyzed, from which the most unfavorable distribution (max or min)
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is taken. However, this distribution only rarely reflects the moment distribution in the individual
load combinations. Therefore, unfavorable values forMe may be applied for result combinations.

In the dialog box Details, tab General you can specify how result combinations of the ‘or’ type are
to be handled for the design (see Chapter 3.1.4, page 31).

Result combinations should be selected for design only in case of dynamic combinations. For
“ordinary” combinations, load combinations are recommended, since there are the actualmoment
distributions taken for the determination ofMe.

2.1.2 Serviceability Limit State

Figure 2.6: Window 1.1 General Data, tab Serviceability Limit State

Existing Load Cases and Combinations
This section lists all load cases, load and result combinations that have been created in RFEM or
RSTAB.

Selected for Design
You can add or remove load cases, load combinations, and result combinations as described in
Chapter 2.1.1.

Chapter L of the Aluminum Design Manual [2] provides recommendations concerning the deflec-
tions for serviceability. To adjust the preset values, click the [Details] button. The Details dialog
box appears (see Figure 3.3, page 30) where you can change the limits in the Serviceability tab.

In the 1.9 Serviceability DataWindow, you can specify the reference lengths that are governing for
the deformation analysis (see Chapter 2.9, page 25).
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2.2 Materials
This window is subdivided into two parts. The upper part lists all materials created in RFEM or
RSTAB. The Material Properties section shows the properties of the current material, that is, the
table row currently selected in the upper section.

Figure 2.7: Window 1.2 Materials

Materials that will not be used in the design are dimmed. Materials that are not allowed are
highlighted in red. Modified materials are displayed in blue.

The material properties that are required to determine the internal forces are described in Chapter
4.3 of the RFEM manual and Chapter 4.2 of the RSTAB manual (Main Properties). The material
properties required for design are stored in the global material library, too. Those values are preset
(Additional Properties).

You can adjust the units and decimal places of thematerial properties and stresses using themenu
Settings → Units and Decimal Places (see Chapter 7.3, page 58).

Material Description
The materials defined in RFEM or RSTAB are preset, but you can always modify them: To do this,
click the material in column A. Then click or press function key [F7] to open the material list.

Figure 2.8: List of Materials

According to the design concept of the Specification [2], only materials of the Aluminium category
are available in the list.
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When you have imported a material, the design-relevantMaterial Properties are updated.

If you change the material description manually and the entry is stored in the material library,
RF-/ALUMINUM ADMwill import the material properties, too.

Generally, the material properties are not editable in the RF-/ALUMINUM ADM add-on module.

Material Library
Many materials are available in a library. To open the material library, click

Edit → Material Library

or use the button shown on the left.

Figure 2.9: Dialog boxMaterial Library

In the Filter section, the current Aluminiummaterial category is preset. Select the specific material
in the Material to Select list. You can check the corresponding properties in the dialog section
below.

Click [OK] or use the [ ] button to transfer the selected material to Window 1.2.

Chapter 4.3 of the RFEMmanual and Chapter 4.2 of the RSTAB manual describe howmaterials can
be filtered, added, or rearranged in the library.
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2.3 Cross-Sections

This window lists the cross-sections used for design. In addition, you can specify optimization
parameters here.

Coordinate System
The sectional coordinate system yz of RF-/ALUMINUM ADM corresponds to the one of RFEM or
RSTAB (see image in Figure 2.10). The y-axis represents themajor principal axis of the cross-section,
the z-axis the minor axis. This coordinate system is used for both the input data and the results.

Figure 2.10: Window 1.3 Cross-Sections

Cross-Section Description
The cross-sections defined in RFEM or RSTAB are preset together with the assigned material num-
bers.

If you want to modify a cross-section, click the entry in column B. Then click [Cross-Section Library]
or in the box, or press the function key [F7] to open the cross-section table of the current
cross-section (see Figure 2.11).

In this dialog box, you can select a different cross-section type. To select a different cross-section
category, click [Back to Library] to access the general cross-section library.

Chapter 4.13 of the RFEMmanual andChapter 4.3 of the RSTABmanual describe howcross-sections
can be selected from the library.

RF-/ALUMINUMADMdesignsmany types of cross-sections from the library or SHAPE-THIN sections.
If the type of a section is General (see Figure 2.12), not all design options are available, however.
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Figure 2.11: Parametric rectangular hollow section

RF-/ALUMINUM ADM performs all relevant designs for the following cross-section types:

• I-sections: rolled/welded, doubly symmetrical or mono-symmetric about the z-axis

• Hollow and box sections: rolled/welded, square-edged/rectangular, doubly-symmetrical

• Massive cross-sections: circular/rectangular

• Pipes

• Angles: rolled/welded simple sections with equal or unequal legs

• T-sections: rolled/welded, symmetrical about z-axis

• Channel-sections: rolled/welded, symmetrical about y-axis

Figure 2.12: Cross-sections of type General (highlighted)
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You can directly enter the new cross-section description in column B. If the entry is listed in the
database, RF-/ALUMINUM ADM imports the cross-section parameters.

A modified cross-section will be highlighted in blue.

If the cross-sections in RF-/ALUMINUM ADM are different from the ones used in RFEM or RSTAB,
both cross-sections are displayed in the graphic on the right. The designs will be performed for
the cross-section selected in RF-/ALUMINUM ADM, using the internal forces from RFEM or RSTAB.

Cross-Section Type
The programdisplays the cross-section type thatwill be used for the design. The nominal strengths
and stability design depend on the type of cross-section. Cross-sections that are classified as
General (see Figure 2.12) can only be designed for specific criteria.

Max. Design Ratio
This column is displayed after the calculation. It is useful to decide on the optimization of sections.
The design ratios and colored relation scales show you which cross-sections have low utilizations
and, thus, are oversized, or which ones are overloaded and undersized.

Optimize
You can optimize cross-sections from the library: For the RFEM/RSTAB internal forces, the program
searches the section that comes as close as possible to a user-defined maximum ratio. You can
define that maximum ratio in the Details dialog box, tab General (see Figure 3.4, page 31).

To optimize a cross-section, open the corresponding drop-down list in column D or E and select
From current row. Recommendations on the optimization can be found in Chapter 7.2 on page 56.

Remark
This column shows remarks in the form of footers that are explained below the cross-section list.

Member with Tapered Cross-Section
For tapered members with different cross-sections at the member start and member end, the
module displays both section numbers in two rows, in accordance with the definition in RFEM or
RSTAB.

RF-/ALUMINUM ADM also designs tapered members, provided that the cross-section at the mem-
ber start has the same number of stress points as the cross-section at themember end. The normal
stresses, for example, are determined from the moments of inertia and the centroidal distances of
the stress points. If the cross-section at the start and the end of a taperedmember have a different
number of stress points, the intermediate values cannot be interpolated.

The stress points including their numbering can also be checked graphically: Select the cross-sec-
tion in Window 1.3 and click the [Info] button. The dialog box shown in Figure 2.13 appears.
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Info About Cross-Section
In the Info About Cross-Section dialog box, you can see the cross-section properties, stress points,
and c/t-parts.

Figure 2.13: Dialog box Info About Cross-Section

The buttons below the cross-section graphic have the following functions:

Button Function

Display or hide the stress points

Display or hide the cross-section c/t-parts.

Display or hide the numbering of stress points or c/t-parts

Display the details of stress points or c/t-parts (see Figure 2.14)

Display or hide the cross-section dimensions

Display or hide the principal axes of the cross-section

Reset the full view of the cross-section graphic

Table 2.2: Buttons of cross-section graphic

Click [Details] to call up detailed information on stress points (centroidal distances, statical mo-
ments of area, warping constants etc.) and c/t-parts (see Figure 2.14).
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Figure 2.14: Dialog box Stress Points of symmetric I-section

2.4 Intermediate Lateral Restraints

In Window 1.4, you can define lateral restraints along each member. In RF-/ALUMINUM ADM, this
kind of support is always perpendicular to the minor z-axis of the cross-section (see Figure 2.13).
Thus, you can manipulate the effective lengths which are important for the stability analyses.

Figure 2.15: Window 1.4 Intermediate Lateral Restraints

In the upper table of the window, you can assign up to nine lateral restraints to every member.
The Settings section shows the entry in a column overview for the member selected above.
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To define the lateral restraints of a member, select the Lateral Restraints check box in column A. To
graphically select the member, click . If you select the check box, the other columns become
accessible and you can enter the parameters.

In column C, you can specify the Number of the intermediate restraints. Depending on the input,
one or more of the following Intermediate Lateral Restraints columns are available for the definition
of the x-locations.

If you select the Relatively (0 ... 1) check box, you can define the support points by relative input.
The positions of the intermediate restraints are determined by themember length and the relative
distances of the member start. If you clear the Relatively (0 ... 1) check box, it is possible to define
the distances manually in the upper table.

2.5 Effective Lengths - Members

The window is subdivided into two parts. The upper table includes summarized information
about the length factors of buckling, lateral-torsional and flexural-torsional buckling as well as
the equivalent lengths of the members. The lengths of the members are preset. In the Settings
section, you can see additional information about the member selected in the upper table.

Click to select a member graphically and show its row.

You can make any changes in the upper table as well as in the Settings tree.

Figure 2.16: Window 1.5 Effective lengths - Members

The effective lengths for buckling about theminor z-axis are aligned automatically with the entries
of the 1.4 Intermediate Lateral RestraintsWindow. If a member is divided into segments of different
lengths, no values are displayed in the table columns G, J, and K of Window 1.5.

You can enter the effective lengths manually in the table and in the Settings tree, or define them
graphically in the work window by clicking the button. The button is active when you place the
cursor in the text box (see Figure 2.16).
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The Settings tree includes the following parameters:

• Cross-Section

• Length of the member

• Buckling Possible for the member (cf. column A)

• Buckling About Major Axis y Possible (cf. columns B to D)

• Buckling About Minor Axis z Possible (cf. columns E to G)

• Lateral-Torsional Buckling Possible (cf. columns H to L)

• Member Type (cf. columns M and N)

In the table, you candetermine abuckling analysis or lateral-torsional andflexural-torsional analysis
to be performed for the selected member. In addition, you can adjust the Effective Length Factor
for the respective lengths. If you modify any factor, the equivalent member length is adjusted
automatically, and vice versa.

You can also define the effective length of a member in a separate dialog box. To open it, click the
button shown on the left (it is located below the upper table).

Figure 2.17: Dialog box Select Effective Length Factor

In this dialog box, the Theoretical or Recommended values of the K factor can be defined that are to
be assigned to the selected member. The theoretical and the recommended values are described
in the Commentary on the Specification for Structural Steel Buildings [4] Table C-C2.2. Generally, it is
possible to select predefined K factors or to enter User-defined values.

If an eigenvalue analysis has been performed in the RF-STABILITY or RSBUCK add-on module, you
can import the respective Bucklingmode in order to determine the factor.
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Buckling Possible
The stability analysis for buckling, lateral-torsional and flexural-torsional buckling requires the
ability of members to absorb compressive forces. Members for which this is not possible due to
their types (for example tension members, elastic foundations, rigid couplings) are excluded from
the analysis a priori. The corresponding rows are dimmed and a note appears in the Comment
column.

The Buckling possible check boxes in table row A and in the Settings tree enables you to control
the stability design according to [2] Chapter C. They determine whether the analyses are to be
performed for the members.

Buckling About Axis y / z
The Possible columns control if there is a buckling risk about the y-axis and/or z-axes. The y-axis
represents the “major” principal member axis, the z-axis the “minor” axis. You can freely select the
effective length factors Ky and Kz for buckling about the major and minor axes.

You can check the member axes in the cross-section graphic in the 1.3 Cross-SectionsWindow (see
Figure 2.10, page 11). To access the RFEM or RSTAB work window, click the [ViewMode] button.
There you can display the local member axes via the shortcut menu of a member or the Display
navigator.

Figure 2.18: Selecting the member axis system in the Display navigator of RFEM

If buckling is possible about one or both member axes, you can enter the buckling length factors
in columns C and F or the effective lengths in columns D and G. The same is possible in the Settings
tree.

To specify the effective lengths in the work window graphically, click . You can click the button
only if the cursor is placed in a KyL or KzL text box (see Figure 2.16).

When you specify the effective length factor K, the program determines the effective length KL
by multiplying the member length L by the effective length factor. The text boxes K and KL are
interactive.

Lateral-Torsional and Flexural-Torsional Buckling
Column H controls which members are included in the analysis of lateral-torsional and flexural-tor-
sional buckling.

The effective lengths Lw and LT can be defined in columns J and K. Lw represents the LTB unbraced
length Lb as referred to in [2] Chapter F (Flexure), whereas LT corresponds to the torsional and
flexural-torsional unbraced length Lz of [2] Chapter E (Compression).
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If lateral restraints have been defined in Window 1.4 Intermediate Lateral Restraints, there is no
possibility to apply any user-defined values.

To determineMe by the Eigenvaluemethod, a member with four degrees of freedom at either side
is created internally for the design. For Beammember types (see columns M and N), the lateral
and torsional restraints are assumed to be fixed while the warping restraint is free. For Cantilever
member types, however, lateral, torsional, and warping restraints are all assumed to be fixed while
the free end is of course assumed to be free.

Alternatively, you can apply the values according to [2] Chapter F or define themManually in the
Settings table.

Member Type
For the design, the member lengths are considered variably for the brace points of a Beam or
Cantileverwith free ends. The relevant boundary settings can be selected in the list box for each
member axis.

Comment
In the last column, you can enter your own comments for each member, for example to describe
the equivalent member lengths.

Set Input for Members No.
Below the Settings table, you find the Set input formembers No. check box. When you select the
check box, the subsequent settings will be applied to the selected members or Allmembers (you
can enter the member numbers manually or select them graphically using the button). This
option is useful when you want to assign the same boundary conditions to several members (see
also https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/000726).
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2.6 Effective Lengths - Sets of Members

This window is available when you have selected one or more sets of members for design in the
1.1 General DataWindow (see Figure 2.1, page 5).

Figure 2.19: Window 1.6 Effective Lengths - Sets of Members

The concept is similar to the previous 1.5 Effective Lengths - MembersWindow. Here you can enter
the effective lengths for buckling about the two principal axes of the set of members, as described
in Chapter 2.5.

2.7 Nodal Supports - Set of Members

This window appears when at least one set of members has been selected in the 1.1 General Data
Window for design and when the option Do not usemember-like input is set in the Details dialog
box (see Figure 3.2, page 28).

The stability design of sets of members is carried out according to Chapter C of the Aluminum
Design Manual [2]. According to Chapter E, you can design doubly symmetric, singly symmetric
and unsymmetric cross-sections stressed by compression and/or bending in a plane. To obtain the
critical momentMe, a planar framework is createdwith four degrees of freedomwhose parameters
are to be defined in Window 1.7.
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Figure 2.20: Window 1.7 Nodal Supports - Set of Members

The current tablemanages theboundary conditionsof the set ofmembers selected in thenavigator
on the left!

The supports defined in RFEM or RSTAB, such as the supports in Z of a continuous beam, are not
relevant in this window. The program imports the distributions of moments and shear forces
automatically from RFEM/RSTAB. You can define several support conditions here that have an
impact on stability failure (buckling, lateral-torsional buckling).

Supports on the start and end nodes of a set of members are preset. Any other supports, for
example as a result of additional members, has to be added manually. You can select nodes
graphically in RFEM/RSTAB work window using the button.

The orientation of axes in a set of members is important for the definition of nodal supports.
The program checks the position of nodes and internally defines the axes of nodal supports
for Window 1.7, according to Figure 2.21 to Figure 2.24. The [Local Coordinate System] but-
ton below the model graphic can help you with the orientation. With it, you can display the
set of members in a partial view where the axes are shown (see also Knowledge Base article
https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/000961).

Figure 2.21: Auxiliary coordinate system of nodal supports - straight set of members

If all members of a set of members are on a straight line (see Figure 2.21), the local coordinate
system of the first member in this set of members is applied for the entire set.
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Figure 2.22: Auxiliary coordinate system of nodal supports - set of members in vertical plane

If the members of a set of members are not on a straight line, they still must be located in one
plane. In Figure 2.22, the members are in a vertical plane. In this case, the X′-axis is horizontal
and it is oriented in the direction of the plane. The Y’-axis is horizontal as well and defined as
perpendicular to the X′-axis. The Z′-axis is oriented perpendicularly downwards.

Figure 2.23: Auxiliary coordinate of nodal supports - set of members in horizontal plane

If the non-straight members are in a horizontal plane, the X′-axis is defined parallel to the X-axis of
the global coordinate system. Thus, the Y′-axis is oriented in the opposite direction to the global
Z-axis, and the Z′-axis is directed parallel to the global Y-axis.

Figure 2.24: Auxiliary coordinate system of nodal supports - set of members in inclined plane

Figure 2.24 shows the general case of a non-straight set of members where the members are in an
inclined plane. The definition of the X′-axis results from the intersection line between the inclined
andhorizontal planes. Thus, theY′-axis is perpendicular to theX′-axis anddirectedperpendicularly
to the inclined plane. The Z′-axis is defined perpendicular to the X′-axis and Y′-axis.
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The buttons below the graphic have the following functions:

Button Function

Display the model or the system sketch

Display the members as a 3D rendering or a wireframe model

Display the current set of members or the entire model

Display the irrelevant members of the model transparent or opaque

Display the set of members in the local coordinate system or the entire model

Show the view in the direction of the X-axis

Show the view against the Y-axis

Show the view in the direction of the Z-axis

Display the isometric view

Table 2.3: Buttons of cross-section graphic

Click the button to determine the constant of a warp spring at the supported nodes.

Figure 2.25: Dialog box Edit Warp Spring

In the Edit Warp Spring dialog box, you can select one of the following types of warp springs:

• End plate

• Channel section

• Angle

• Connecting column

• Cantilevered portion

You can select the materials and cross-sections using the lists and [Library] buttons. Click the
button for graphical selections in the RFEM or RSTAB model.

RF-/ALUMINUM ADM determines the Resulting warp spring Cu� from the parameters. By clicking
[OK], you import the result in Window 1.7.
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2.8 Member Hinges - Set of Members

This window appears when at least one set of members has been selected in the 1.1 General Data
Window and when the option Do not use member-like input is set in the Details dialog box (see
Figure 3.2, page 28). In this window, you can define releases for members within sets of members
that do not transfer specific internal forces for structural reasons. Make sure that no double hinges
are created in interaction with Window 1.7.

The current table manages the parameters of the set of members selected in the navigator on the
left.

Figure 2.26: Window 1.8 Member Hinges - Set of Members

TheMember No. is to be entered in column A. Alternatively, use the button of the text box to
select the member graphically in the work window.

In column B, you define theMember Side on which the hinge is located. You can also allocate the
hinge to both member ends.

The table columns C to F control the hinges – or spring constants – of each release. By these hinges,
you can adjust the set of members model to the real boundary conditions.
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2.9 Serviceability Data

This window controls important settings of the serviceability limit state design. It is displayed
when you have entered the corresponding data in the Serviceability Limit State tab of Window 1.1
(see Chapter 2.1.2, page 8).

Figure 2.27: Window 1.9 Serviceability Data

In column A, you decide whether the analysis of the deflections refers to single members or sets
of members.

Column B controls the numbers of members or sets of members that are to be designed. You
can select the objects graphically in the RFEM or RSTAB work window using the button. The
Reference Length is then shown in column D. This value represents the length of the member or
set of members. If required, you can adjust itManuallywhen you have selected the check box in
column C.

In column E, you can define the governing Direction for the deflection analysis. You can select the
directions of the local member axes y and z (or u and v for unsymmetrical cross-sections).

Table columnFenables you to take into account apossiblePrecamberwc. By default, theprecamber
refers to the major axes z and v. To change this, click the [Details] button. The Details dialog box
appears (see Figure 3.3, page 30) where you can set the minor axes y and u in the Serviceability tab.

For the correct application of limit deformations, the Beam Type is essential. In column G, you can
specify whether a beam or a cantilever is to be designed and which end is without support.

The setting in the Serviceability tab of the Details dialog box controls whether the deflections are
related to the undeformed model or to the shifted ends of members or sets of members (see
Figure 3.3, page 30).
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2.10 Parameters - Members

In the last window, you can define specific parameters for members subjected to axial tension.

Figure 2.28: Window 1.10 Parameters - Members

Cross-Sectional Area
When you select the check box of a member, the Settings table below becomes accessible where
you can modify the cross-sectional area for tension design. By defining the net cross-sectional
area An, you can control the effective net area of the section Ae to account for the effect of shear
lag. Furthermore, eccentricities of the connection can be definied which refer to the local axes x
and y of the member. Those have an influence on the effective net cross-sectional area, too.

The above-mentioned parameters can be specified for the Start and the End of each member.

Comment
In this column, you can enter user-defined comments for each member.

Below the Settings table, you find the Set input formembers No. check box. When you select the
check box, the subsequent settings will be applied to the selected members or Allmembers (you
can enter the member numbers manually or select them graphically using the button).
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3 Calculation

3.1 Detail Settings

Before you start the calculation, it is recommended to check the design details. You can access the
corresponding dialog box in all windows of the add-on module by clicking the [Details] button.

The Details dialog box has the following tabs:

• Ultimate Limit State

• Stability

• Serviceability

• General

3.1.1 Ultimate Limit State

Figure 3.1: Dialog box Details, tab Ultimate Limit State

The buttons in the Details dialog box have the following functions:

Button Function

Reset default settings of the program

Load user-defined default settings

Save modified settings as default

Table 3.1: Buttons in Details dialog box
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Options
The Structure type options control whether the model is designed for the nominal loads and load
combinations as appropriate for building-type structures (cf. [2] Section B.2.1) or for bridge-type
structures (cf. [2] Section B.2.2). The Load and Resistance Factor Design (LRFD) is limited to build-
ing-type structures.

For flat elements in uniform compression or flexure, the Direct strengthmethod can alternatively
be applied according to [2] Sections B.5.4.6 and B.5.5.5.

Solid cross-sections

By default, the Shear design of solid cross-sections is enabled. The figure to the left shows all types
of solid cross-sections which can be defined by their parameters in RFEM or RSTAB.

The Shear buckling design of the members can be disabled if it is not revelant for the design case.

Optionally, a General elastic design of simple shear based on shear stress can be performed. In that
case, the limit state stresses based on elastic parameters are applied for the elements.

Limit Internal Forces for Interaction / Special Cases
For the design of members for combined forces and torsion, it is possible to ignore the torsional

components of the stresses. If the shear ratios fs
Fsy/𝛺T

(no square) do not exceed the default of

50% for interaction, torsion is not considered in the design.

In the same way, you can ignore effects due to shear and torsion according to [2] Section H.3. If
the shear ratios do not exceed the default of 1%, they are not considered.

These values are not part of the Specification [2]. They should be adjusted by the user to the
respective situations.

3.1.2 Stability

Figure 3.2: Dialog box Details, tab Stability
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Stability Analysis
The Perform stability analysis check box controls whether to run a stability analysis in addition to
the cross-section designs. If you clear the check box, the Windows 1.4 through 1.8 are not shown.

Lateral-Torsional Buckling
When there are transverse loads, the location must be specified at which those forces are acting:
Depending on the load application point, the transverse loads can be stabilizing or destabilizing,
which has an influence on the elastic critical moment.

Set of Members - Member-Like Input
By default, themember-like input is not applied for sets of members. Thatmeans that the boundary
conditions have to be defined in Windows 1.7 Nodal Supports and 1.8Member Hinges for each set
of members.

Alternatively, it is possible to treat sets of members as “one longmember”. For that, you can define
the factors Kz and Kw in Window 1.6 Effective Lengths - Sets of Members. Those factors are used to
determine the support conditions 𝛽 , uy, 𝜑x, 𝜑z, and 𝜔. In that case, the Windows 1.7 and 1.8 are
not displayed.

If at all, it is recommended to use the member-like input method for straight sets of members only.

Limit Values for Special Cases
To design cross-sections with compression according to [2] Section E, it is possible to neglect small
moments about the major and/or minor axes. The default values in the two text boxes are 1%,
which represents the ratio of design moment and strength.

For the straight check of bending according to [2] Section F, you can similarly neglect small com-
pression forces by a user-defined limit ratio.

These limit settings are not part of the Specification [2]. It is the responsibility of the user to apply
or modify them.
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3.1.3 Serviceability

Figure 3.3: Dialog box Details, tab Serviceability

Deformation Relative To
The two options specify whether the maximum deformations are to be referred to the shifted
ends of the members / sets of members (i.e. line between first and last shifted nodes of deformed
model) or to the undeformed initial system.

In most cases, the deformations are designed as relative to the displacements of the entire model.

The following Knowledge Base article illustrates how to refer deflections:
https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/001081

Serviceability Limits (Deflections) Chapter L.3
In the two text boxes, you can check and, if necessary, adjust the limit deformations for beams
and cantilevers.

Chapter L of the Aluminum Design Manual [2] provides recommendations concerning the deflec-
tions for serviceability. In RF-/ALUMINUM ADM, the existing deflections are compared to the limit
values which refer to the lengths of the members or sets of members. Recommendations on the
limit values can be found in the Commentary on the Specification for Structural Steel Buildings [4]
Section L3, for example.
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Direction of Precamber
By default, the precamber as specified in Window 1.9 Serviceability (see Figure 2.27, page 25) refers
to the major axes z and v. If appropriate, the minor axes y and u can be set.

3.1.4 General

Figure 3.4: Dialog box Details, tab General

Calculation of Result Combinations with OR Type
When combinations are created automatically, often many load combinations (LCs) are produced.
Usually, they are summarized in a result combination (RC) as alternatively effective (“OR com-
bination”) in order to determine the enveloping results: LC1/p or LC2/p or LC3/p or LC4/p etc.
RF-/ALUMINUM ADM provides two options to design this result combination:

The components of each load combination can be analyzed separately. By this, the elastic critical
moments are specifically determined for each load arrangement and then used for the design.
This approach gives the exact results but implies a rather high demand of computing time as well.

Alternatively, the result combination can be analyzed comprehensively. The calculation is faster
because only the extreme values with the corresponding internal forces are used for the design.
The results, however, may be not be on the safe side if there is a RC with one combination in which
several internal forces (e.g. N andMy) are all slightly below the overall extremes.
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Cross-Section Optimization
By default, the optimization is targeted on the maximum allowable design ratio of 100%. You can
set a lower (or higher) limit in the text box.

Check of Member Slendernesses
In the text boxes, you can specify the limit values 𝜆limit of the member slendernesses. It is possible
to enter the specifications separately for members with tension forces only and for members with
compression and flexure. The slenderness ratios are given in the tables of [2] Part VI.

The limit values are compared to the actual member slendernesses. These results are listed in the
3.3Member SlendernessesWindow (see Chapter 4.8, page 41) when the corresponding check box
has been selected in the Display Result Windows dialog box section (see below).

Cross-Section Database

Rolled cross-sections

In general, aluminum cross-sections are fabricated by extrusion molding. When the check box is
selected, the design covers rolled steel cross-sections – possiblywith aluminummaterial properties –
of the library, too.

The figure to the left shows the rolled types of library cross-sections.

Settings of SHAPE-THIN Cross-Sections
For closed shapes of cross-sections, the nominal flexural strengths that are to be applied are
different from those for open sections (see [2] Sections F.4.2.1 and F.4.2.3 for lateral-torsional
buckling). Closed shapes resist lateral-torsional buckling primarily by torsional resistance.

RF-/ALUMINUMADMclassifies SHAPE-THIN sections as closedwhen the share of the Bredt torsional
resistance JBredt of the overall torsional resistance J is greater than the value set in the text box.

Display Result Windows
In this dialog section, you can select the resultwindows, includingparts list, that are to bedisplayed.
The windows are described in Chapter 4 - Results.

The 3.3 Member SlendernessesWindow is deactivated by default.
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3.2 Start Calculation

In all input windows of the RF-/ALUMINUM ADMmodule, you can start the calculation by clicking
the [Calculation] button.

RF-/ALUMINUM ADM searches for the results of the relevant load cases, load and result combina-
tions. If they are not available yet, the program starts the calculation in RFEMor RSTAB to determine
the respective internal forces.

You can also start the calculation in the RFEM/RSTAB user interface: The To Calculate dialog box
(menu Calculate→ To Calculate) includes the design cases of add-on modules, similar to load
cases and load combinations.

Figure 3.5: Dialog box To Calculate

If the RF-/ALUMINUM ADM design cases are missing in the Not Calculated list, select All or Add-on
Modules in the drop-down list below.

Select the RF-/ALUMINUM ADM case and transfer it to the list on the right with the button.
Then click [OK] to start the calculation.

To calculate a design case directly, use the list in the toolbar. Select the RF-/ALUMINUM ADM case
in the toolbar list and click [Show Results].

Figure 3.6: Direct calculation of a RF-ALUMINUM ADM case in RFEM

You can then follow the design process in a separate dialog box.
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4 Results
This chapter describes the result windows one by one. The evaluation of the results is described
in Chapter 5.

After the calculation, the 2.1 Design by Load CaseWindow is displayed.

Figure 4.1: Result window with designs and details of results

The designs are presented in the result Windows 2.1 to 2.5. They are sorted by different criteria.

Windows 3.1 and 3.2 list the governing internal forces, Window 3.3 gives information on the
member slendernesses. The last two Windows 4.1 and 4.2 show the parts lists for members and
sets of members.

Every window can be selected by clicking the corresponding entry in the navigator. To set the
previous or next window, use the buttons shown on the left. You can also use the function keys to
select the next [F2] or previous [F3] window.

[OK] saves the results. RF-/ALUMINUM ADM is closed and you return to the main program.
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4.1 Design by Load Case

The upper part of the window shows a summary of the governing designs. They are sorted by
load case, load combination, and result combination. Furthermore, the table is divided in Ultimate
Limit State Design and Serviceability Limit State Design results.

The lower part of the window contains the Details of the cross-section properties, internal forces,
and design parameters for the load case that is selected in the upper table.

Figure 4.2: Window 2.1 Design by Load Case

Description
In the first column, the descriptions of the load cases, load and result combinations used for the
designs are displayed.

Member No.
This column contains the numbers of the members that have the highest design ratios of each
designed load case or combination.

Location x
This column shows the x-locations of each member where the highest design ratios occur. For the
table output, the program uses the following member x-locations:

• Start and end node

• Division points according tomember division as defined in RFEMTable 1.16 or RSTAB Table 1.6

• Division of members according to specification for result diagrams (Calculation Parameters
dialog box, Global Calculation Parameters tab in RFEM or RSTAB)

• Extreme values of internal forces
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Design Ratio
Columns D and E show the terms of design according to [2]. The lengths of the colored bars
represent the respective design ratios.

Design According to Formula
This column lists the Sections of the Specification [2] by which the designs have been performed.

DS
The last column provides information on the design situations: ULS or SLS for the ultimate limit
state or serviceability limit state design.

4.2 Design by Cross-Section

Figure 4.3: Window 2.2 Design by Cross-Section

In the upper table, the highest ratios of all designed members and load cases or combinations are
listed by cross-section. The results are sorted by cross-section design and stability analysis, as well
as serviceability limit state design.

For a tapered member, the cross-sections of the member start and of the member end are listed
separately.
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4.3 Design by Set of Members

This result window is displayed when you have selected at least one set of members for design.
The table lists the highest design ratios of each set of members.

Figure 4.4: Window 2.3 Design by Set of Members

The columnMember No. shows the number of the member within the set that has the highest
stress ratio for the respective design criteria.

The output by set of members presents the maximum design results of structural groups, such as
frames or multi-part columns.
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4.4 Design byMember

Figure 4.5: Window 2.4 Design byMember

In this window, the highest ratios of the cross-section checks, stability analyses, and serviceability
designs are shown. The results are sorted by member number.

4.5 Design by x-Location

Figure 4.6: Window 2.5 Design by x-Location
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This window lists the maximum values of each member at every location x:

• Start and end node

• Division points according tomember division as defined in RFEMTable 1.16 or RSTAB Table 1.6

• Division of members according to specification for result diagrams (Calculation Parameters
dialog box, Global Calculation Parameters tab in RFEM or RSTAB)

• Extreme values of internal forces

4.6 Governing Internal Forces byMember

Figure 4.7: Window 3.1 Governing Internal Forces byMember

For every member, this window displays the governing internal forces. Those are the internal
forces that result in the maximum design ratios of each design.

Location x
This column informs you about the x-locations of each member where the highest ratios occur.

Loading
This column shows numbers of the load cases and combinations whose internal forces result in
the maximum design ratios for each type of design.

Forces / Moments
For every member, this column displays the axial and shear forces as well as the torsional and
bending moments that give the maximum ratios each design.
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Design According to Formula
The last column shows the types of design and gives the Sections of the Specification [2] that were
used for the analysis.

4.7 Governing Internal Forces by Set of Members

Figure 4.8: Window 3.2 Governing Internal Forces by Set of Members

This result window is displayed when you have selected at least one set of members for design.
The table lists the internal forces that result in the highest ratios for each set of members.
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4.8 Members Slendernesses

This window is shown when you have selected the respective check box in the Details dialog box,
tab General (see Figure 3.4, page 31).

Figure 4.9: Window 3.3 Member slendernesses

The table lists the effective slendernesses of the designed members for both directions of the
principal axes. They are determined in compliance with the load type. At the end of the list, there
is a comparison with the limit values that have been defined in the Details dialog box, tab General
(see Figure 3.4, page 31).

Members of the member types “Tension” or “Cable” are not included in the table.

This window is displayed only for information. No stability analysis of the slendernesses is provided.
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4.9 Parts List byMember

Finally, RF-/ALUMINUM ADM gives a summary of all designed cross-sections.

Figure 4.10: Window 4.1 Parts List byMember

By default, the table contains only the designed members. If you need a parts list of all members,
select the corresponding option in the Details dialog box, tab General (see Figure 3.4, page 31).

Part No.
The program automatically assigns item numbers to identical members.

Cross-Section Description
In this column, the numbers and descriptions of the cross-sections are listed.

Number of Members
This column shows howmany identical members are used for each part.

Length
In column C, the lengths of the representative members are given.

Total Length
The values in this column represent the product of the previous two columns.

Surface Area
The area, which is related to the total length, is determined from the Surface of the cross-sections. It
can be checked inWindows 1.3 and 2.1 through 2.5 in the Info dialog box (see Figure 2.13, page 14).
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Volume
The volume of each part is determined from the cross-sectional area and total length.

Unit Weight
The mass of a cross-section is related to the length of one meter. For tapered cross-sections, the
program averages both section properties.

Weight
The values of this column represent the product of columns C and G.

Total Weight
The final column gives the total mass of each part.

Sum
At the bottom of the list, you find a summary of the values in columns B, D, E, F, and I. The last row
of the Total Weight column shows the total amount of required aluminum.

4.10 Parts List by Set of Members

The last result window is displayed when you have selected at least one set of members for design.
The table summarizes structural groups in a parts list, for example horizontal beams.

Figure 4.11: Window 4.2 Parts List by Set of Members

Details on the columns can be found in Chapter 4.9. If different cross-sections are used in a set of
members, the program averages the surface area, the volume, and the cross-section weight.
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5 Results Evaluation
You can evaluate the results in many ways. For this, the buttons below the upper table are useful.

Figure 5.1: Buttons for results evaluation

The buttons have the following functions:

Button Description Function

Ultimate Limit State
Designs

Display or hide the results of ULS design

Serviceability Limit
State Designs

Display or hide the results of SLS design

Result Combination
Create a new result combination from the governing load
cases and load combinations

Color Bars Display or hide the colored relation scales in the result tables

Filter Parameters
Define the criterion to filter results in tables:
ratios greater than 1, maximum, or user-defined limit

Apply Filter
Display only the rows with applied filter parameter (ratios
greater than 1, maximum, user-defined limit)

Result Diagrams
Open the Result Diagram onMemberWindow
→ Chapter 5.2, page 48

Excel Export
Export the table to MS Excel or OpenOffice
→ Chapter 7.4.3, page 59

Member Selection Select a member graphically to display its results in the table

View Mode Jump to the RFEM/RSTAB work window to change the view

Table 5.1: Buttons in the result windows 2.1 to 2.5
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5.1 Results in RFEM/RSTABModel

You can evaluate the results graphically in the RFEM or RSTAB work window.

RFEM/RSTAB background graphic and viewmode
The RFEM or RSTAB work window in the background is useful when you want to find a specific
member in the model: The member selected in the result window of RF-/ALUMINUM ADM is
highlighted in the selection color in the background graphic. An arrow indicates the relevant
x-location of the member that is selected in the table.

Figure 5.2: Indication of member and relevant Location x in the RFEMmodel

If you cannot improve the view by moving the RF-/ALUMINUM ADMwindow, click the button
to activate the View mode: The program hides the window so that you can modify the display
in the RFEM/RSTAB user interface. The view mode provides the functions of the Viewmenu, for
example zooming, moving, or rotating the view. The pointer remains visible.

Click [Back] to return to the RF-/ALUMINUM ADM add-on module.
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RFEM/RSTABwork window
You can graphically check the design ratios in the RFEM or RSTAB model: Click [Graphics] to exit
the add-on module. Then the design ratios are displayed in the work window of RFEM or RSTAB –
like internal forces of a load case.

In the Results navigator, you can specify which design ratios of the ultimate or serviceability limit
state designs are to be displayed.

Figure 5.3: Results navigator for Ultimate Limit State and Serviceability Limit State designs

To turn the display of results on or off, click the [Show Results] button (likewise to turning internal
forces on or off). To display the result values, click the [Show Values] button to the right of it.

The RFEM/RSTAB tables are not relevant for the evaluation of the RF-/ALUMINUM ADM results.

You can set the design cases (see Chapter 7.1) by means of the list in the RFEM or RSTAB menu bar.

To adjust the graphical representation of the results, you can select Results→Members in the
Display navigator. The display of the design ratios is Two-Colored by default.

Figure 5.4: Display navigator: Results→Members
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When you have chosen one of the multicolor representations (options With/Without Diagram,
Cross-Sections), the color panel is displayed, too. It provides common control functions which are
described in the RFEM or RSTAB manual, Chapter 3.4.6.

Figure 5.5: Design ratios with display optionWithout Diagram

You can transfer the graphics of design results to the printout report (see Chapter 6.2, page 52).

To return to the add-on module, click [RF-/ALUMINUM ADM] in the panel.
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5.2 Result Diagrams

You can also graphically evaluate the member results in the result diagrams.

Select the member (or set of members) in the RF-/ALUMINUM ADM result window by clicking in
the table row of the member. Then, open the Result Diagram onMember dialog box by clicking
the button shown on the left. This button is located below the upper result table (see Figure 5.1,
page 44).

The result diagrams can also be accessed in the work window of RFEM or RSTAB via the menu

Results → Result Diagrams for SelectedMembers

or the corresponding button in the RFEM/RSTAB toolbar.

A new window appears. It shows the distribution of the design ratios along the selected member
or set of members.

Figure 5.6: Dialog box Result Diagram onMember

You can set the results of the ultimate or serviceability limit state designs in the navigator.

Use the list in the toolbar above to select the relevant RF-/ALUMINUM ADM design case.

The Result Diagram onMember dialog box is described in the RFEM or RSTAB manual, Chapter 9.5.
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5.3 Filter for Results

Basically, the RF-/ALUMINUM ADM result windows allow you to sort the results by various cri-
teria. You can also use the filter options (see Figure 5.1, page 44) to reduce the tabular out-
put with respect to design ratios. The function is described in this Knowledge Base article:
https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/000733

Furthermore, you canuse the filter options described inChapter 9.9 of theRFEMmanual to evaluate
the results graphically.

For the RF-/ALUMINUM ADM graphics, you can also use the Visibility options to filter the members
and evaluate them specifically (see RFEMmanual, Chapter 9.9.1 or RSTAB manual, Chapter 9.7.1).

Filtering designs
You can use the design ratios as filter criteria in the work window of RFEM or RSTAB (accessible by
clicking [Graphics]). To apply this function, the panel must be displayed. If it is disabled, click the
RFEM/RSTAB menu

View → Control panel

or use the toolbar button shown on the left.

The panel is described in the RFEM or RSTAB manual, Chapter 3.4.6. The settings for filtering the
ratios canbedefined in the first tab (Color spectrum). As this tab is not available for the two-colored
results, the options ColoredWith/Without Diagram or Cross-Sections have to be set in the Display
navigator.

Figure 5.7: Filtering design ratios with adjusted color scale

Figure 5.7 presents a modified color spectrum: Only ratios greater than 0.50 are displayed in the
color ranges between blue and red.
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The functionDisplay hidden result diagram in theDisplay navigator (Results→Members) displays
all ratios beyond the values of the color spectrum. Those diagrams are drawn as dotted lines.

Filteringmembers
In the Filter tab of the control panel, you can enter the numbers of members whose results you
want to see exclusively. This function is described in Chapter 9.9.3 of the RFEMmanual or Chapter
9.7.3 of the RSTAB manual.

Figure 5.8: Member filter for the design ratios of a box girder

In contrast to the visibility mode, the entire model is displayed. Figure 5.8 shows the design ratios
of one specific box girder. All other members of the model are displayed as well, but they have no
design ratios.
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6 Printout

6.1 Printout Report

In the sameway as for RFEMor RSTAB, a printout report can be created for the RF-/ALUMINUMADM
data. You can illustrate the documentation by individual images and comments. The selection in
the printout report controls which data of the add-on module is included in the final printout.

The printout report is described in the manuals of RFEM and RSTAB. In particular, Chapter 10.1.3.5
Selecting Data of Add-on Modules describes how the input and output data of add-on modules
can be arranged.

Figure 6.1: Selecting designs and intermediate results in the printout report

Click the [Details] button to specify if you want to include the intermediate results in the printout
report as well. You can then select the Chapters toDisplay as seen in Figure 6.1. The detailed results
can be recorded in a Short (compact compilation) or Long (list representation) form.

For complex structural systems with many design cases, it is recommended to split the data into
several printout reports, thus allowing for a clearly-arranged printout.
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6.2 Graphic Printout

In RFEM or RSTAB, you can add every view of the work window to the printout report or send the
image directly to your printer. In this way, you can prepare the design ratios displayed in the RFEM
or RSTAB model for the printout.

The printing of graphics is described in the manuals of RFEM and RSTAB, Chapter 10.2.

Designs in RFEM/RSTABmodel
To print the currently displayed graphic of the design ratios, click

File → Print Graphic

or use the toolbar button shown on the left.

Figure 6.2: Print Graphic button in RFEM toolbar

Result Diagrams
You can also [Print] the Result DiagramonMember to the report by using the corresponding button.
It is also possible to print it directly.

Figure 6.3: Print button in the dialog box Result Diagram onMember

The Graphic Printout dialog box appears.

Figure 6.4: Dialog box Graphic Printout, tab General
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This dialog box is described in detail in the manuals of RFEM and RSTAB, Chapter 10.2, inclusive of
the other tabs of the dialog box.

When you have printed the image to the printout report, you can move it anywhere within the
report by drag-and-drop.

To adjust an image subsequently in the printout report, right-click the relevant entry in the navi-
gator of the report. The Properties option in the shortcut menu opens the Graphic Printout dialog
box again, offering various options for adjustment.

Figure 6.5: Dialog box Graphic Printout, tab Options
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7 General Functions
This chapter describes useful menu functions as well as export options for the designs.

7.1 Design Cases

Design cases allow you to group members for the design. In this way, you can combine groups
of structural elements or analyze members with particular design specifications (for example
modified materials, strengths, restraints, etc.).

It is no problem to analyze the same member or set of members in different design cases.

To calculate a RF-/ALUMINUM ADM design case, you can also use the load case list in the toolbar
of RFEM or RSTAB.

Create NewDesign Case
To create a new design case, use the RF-/ALUMINUM ADMmenu and click

File → New Case.

The following dialog box appears:

Figure 7.1: Dialog box New RF-ALUMINUMADMCase

In this dialog box, enter the (not yet used) Number of the new design case. The Description of the
design case makes the selection in the load case list easier.

Click [OK] to open the 1.1 General DataWindow of RF-/ALUMINUM ADM and enter the new data.

Rename Design Case
To change the description of a design case, use the RF-/ALUMINUM ADMmenu and click

File → Rename Case.

The following dialog box appears:

Figure 7.2: Dialog box Rename RF-ALUMINUMADMCase

In this dialog box, you can specify a differentDescription as well as a differentNumber of the design
case.
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Copy Design Case
To copy the input data of the current design case, use the RF-/ALUMINUM ADMmenu and click

File → Copy Case.

The following dialog box appears:

Figure 7.3: Dialog box Copy RF-ALUMINUMADMCase

Define the Number and, if necessary, a Description for the new case.

Delete Design Case
To delete design cases, use the RF-/ALUMINUM ADMmenu and click

File → Delete Case.

The following dialog box appears:

Figure 7.4: Dialog box Delete Case

You can select the design case in the list of Available Cases. To delete the selected case, click [OK].
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7.2 Cross-Section Optimization

RF-/ALUMINUM ADM offers you the option to optimize overloaded or low-utilized cross-sections.
To do this, open the drop-down list in column D or E in the 1.3 Cross-SectionsWindow and select
Yes (for parametric sections) or From current row (for rolled sections).

You can also start the optimization in the result windows by using the shortcut menu.

Figure 7.5: Shortcut menu in tables

During the optimization, RF-/ALUMINUM ADM determines the section that fulfills the resistance
analysis requirements in themost “optimal”way, that is, comes as close as possible to themaximum
allowable design ratio as specified in the Details dialog box (see Figure 3.4, page 31). The required
cross-section properties are determined with the internal forces from RFEM or RSTAB. If a different
section proves to be more favorable, that one is used for the design. Then, the graphic in Window
1.3 shows two cross-sections: the original section from RFEM/RSTAB and the optimized one (see
Figure 7.7).

When you optimize a parametric cross-section, the following dialog box appears.

Figure 7.6: Dialog box Thin-Walled Cross-Sections - Symmetric I-Section: Optimize

By selecting the check boxes in the Optimize column, you decide which parameter(s) you want to
modify. You can then specify the upper and lower limits of the parameter(s) in theMinimum and
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Maximum columns. The Increment column controls the interval in which the size of the parameter
varies during the optimization.

If you want to Keep current side proportions, select the corresponding check box. Additionnally,
you have to select at least two parameters for the optimization process.

During the optimization, the internal forces are not automatically recalculated with the modified
cross-sections: It is up to you to decide which sections are to be transferred to RFEM or RSTAB for a
new calculation. Due to the optimized cross-sections and modified stiffnesses, the internal forces
of the model may differ considerably. Therefore, we recommend recalculating the internal forces
of the modified model after the first optimization. After that, you can optimize the cross-sections
once again.

To export the modified cross-sections to RFEM or RSTAB, go to the 1.3 Cross-SectionsWindow and
click

Edit → Export All Cross-Sections to RFEM.

Alternatively, you can use the shortcut menu in Window 1.3.

Figure 7.7: Shortcut menu in Window 1.3 Cross-Sections

Before themodified cross-sections are transferred to RFEMor RSTAB, the programasks youwhether
the results of RFEM/RSTAB should be deleted.

Figure 7.8: Query when exporting sections

When you confirm this query and start the [Calculation] in the RF-/ALUMINUM ADMmodule, the
new internal forces and design ratios will be determined in a single calculation run.
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If the modified cross-sections have not been exported to RFEM or RSTAB yet, you can reimport the
original sections in the design module by using the options shown in Figure 7.7. Please note that
this option is only available in the 1.3 Cross-SectionsWindow.

If you optimize a tapered member, the programmodifies the member start and end. After that,
the second moments of area are linearly interpolated for the intermediate locations. Since these
moments are considered with the fourth power, the designs may be inaccurate if the depths of
the start and end cross-section differ considerably. In such a case, it is recommended to divide the
taper into several members, thus modeling the layout of the taper manually.

7.3 Units and Decimal Places

The units and decimal places are managed in one dialog box for RFEM/RSTAB and for all add-on
modules. In RF-/ALUMINUM ADM, you can use the menu to adjust the units by clicking

Settings → Units and Decimal Places.

The Units and Decimal Places dialog box appears which you already know from RFEM or RSTAB.
RF-/ALUMINUM ADM is preset in the Program /Module list.

Figure 7.9: Dialog box Units and Decimal Places

You can save the settings as a user profile to apply them in other models. These functions are
described in Chapter 11.1.3 of the manual of RFEM or RSTAB.
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7.4 Data Transfer

7.4.1 ExportingMaterials to RFEM/RFEM

When you have adjusted the materials in RF-/ALUMINUM ADM for design, you can export the
modified materials to RFEM or RSTAB in a similar way as you export cross-sections: Open the
1.2 MaterialsWindow and then use the menu

Edit → Export All Materials to RFEM/RSTAB.

You can also export themodifiedmaterials to RFEM/RSTAB using the shortcutmenu inWindow 1.2.

Figure 7.10: Shortcut menu in Window 1.2 Materials

Before the materials are transferred to RFEM or RSTAB, the program asks you whether the results
should be deleted. When you confirm the query and start the [Calculation] in RF-/ALUMINUMADM,
the new internal forces and design ratios will be determined in a single calculation run.

If themodifiedmaterials have not been exported to RFEM/RSTAB yet, you can reimport the original
materials in the design module by using the options shown in Figure 7.10. Please note that this
option is only available in the 1.2 MaterialsWindow.

7.4.2 Exporting Effective Lengths to RFEM/RSTAB

When you have adjusted the effective lengths in RF-/ALUMINUM ADM for design, you can export
the modified lengths to RFEM or RSTAB in a similar way as you export cross-sections: Go to the 1.5
Effective Lengths - MembersWindow and click

Edit → Export All Effective Lengths to RFEM/RSTAB

or use the corresponding option in the shortcut menu of Window 1.5.

Figure 7.11: Shortcut menu in Window 1.5 Effective Lengths - Members

Before the effective lengths are transferred to RFEM or RSTAB, the program asks you whether the
results should be deleted.

If themodified effective lengths have not been exported to RFEM/RSTAB yet, you can reimport the
original lengths in Window 1.5 Effective Lengths - Members via the options shown in Figure 7.11.

7.4.3 Exporting Results

The RF-/ALUMINUM ADM results can also be used by other programs.

Clipboard
To copy cells selected in the result tables to the Clipboard, use the keys [Ctrl]+[C]. Press [Ctrl]+[V]
to insert the cells, for example in a word processing program. The headers of the table columns
will not be transferred.
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Printout Report
You can print the data of RF-/ALUMINUM ADM into the global printout report (see Chapter 6.1,
page 51) and export them subsequently by clicking

File → Export to RTF.

The function is described in the manual of RFEM or RSTAB, Chapter 10.1.11.

Excel / OpenOffice
RF-/ALUMINUM ADM provides a function for directly exporting data to MS Excel, OpenOffice Calc,
or the CSV file format. To open the corresponding dialog box, click

File → Export Tables.

The following export dialog box appears:

Figure 7.12: Dialog box Export of Tables

When you have selected the relevant options, you can start the export by clicking [OK]. Excel or
OpenOffice will be started automatically, i.e. you do not need to open the programs first.

Figure 7.13: Results in Excel
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